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Before You Start 

Copyright and Trademark Notices 
 

Copyright. 2013 CaseWare International Inc. (“CWI”). All Rights Reserved. Use, duplication, or 
disclosure by the United States Government is subject to the restrictions set forth in DFARS 
252.227-7013 ©(1)(ii) and FAR 52.227-19.Notice to U.S. Government End Users. This publication 
and the related computer software was developed exclusively at private expense and for the 
purposes of U.S. acquisition regulations the related computer software is “commercial computer 
software” subject to limited utilization (“Restricted Rights”). 

This publication may only be copied and otherwise used as permitted in the applicable license 
agreement and, subject to the express terms of such license, use of this publication is subject to 
the following terms and conditions: 

All copyright and other proprietary notices must be retained on every copy made. 

CWI has not conferred by implication, estoppel or otherwise any license or right under any patent, 
trademark or copyright of CWI or of any third party. 

This publication is provided “as is” without warranty or condition of any kind, either expressed or 
implied, including, but not limited to, the implied warranties of merchantability, fitness for a 
particular purpose, or non-infringement. 

This and related publications may include technical inaccuracies or typographical errors. Changes 
are periodically made to CWI publications and may be incorporated in new editions. 

CWI may improve or change its products described in any publication at any time without notice. 
CWI assumes no responsibility for and disclaims all liability for any errors or omissions in this 
publication or in other documents, which are referred to within or linked to this publication. Some 
jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply 
to you. 

Should you or any viewer of this publication respond with information, feedback, data, questions, 
comments, suggestions or the like regarding the content of any CWI publication, any such 
response shall be deemed not to be confidential and CWI shall be free to reproduce, use, disclose 
and distribute the response to others without limitation. You agree that CWI shall be free to use any 
ideas, concepts or techniques contained in your response for any purpose whatsoever including, 
but not limited to, developing, manufacturing and marketing products incorporating such ideas, 
concepts or techniques. 

This publication is distributed internationally and may contain references to CWI products, 
programs and services that have not been announced in your country. These references do not 
imply that CWI intends to announce such products, programs or services in your country. 

Product names, logos, designs, titles, words or phrases within this publication may be trademarks, 
service marks, or trade names of CWI or other entities and may be registered in certain 
jurisdictions. 

Printed and bound in Canada. 
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Getting Started 

Introduction 
Today is an optional add-in for Microsoft Outlook.  

Today is a series of Microsoft Outlook and Exchange forms, HTML pages and objects integrating 
seamlessly with products so that you can keep information in just one place. Using Today, you 
can take advantage of the tools available in both Time and Microsoft Outlook. 

A lot of needless duplication exists when you have to keep client contact information in several 
software packages such as accounting, contact management, and email, to name a few. 
Updating addresses or phone numbers in one means launching all the applications to update 
them, using time and inviting mistakes. It may take a few months to catch a mistake at which time 
you cannot remember which entry is the most current. 

The idea is that you have everything linked into Today where you can plan, schedule, update 
contact information, access reference information, and jump to your Time files to work directly. 
Using Today allows you to do your time and billing in Time and coordinate required tasks and 
meetings with Outlook, using one set of client contact information synchronized between the two 
packages at regular intervals. 

Minimum requirements 
In order to customize Today, including the setting up of forms and synchronization with Time you 
must ensure that Outlook, Time and Today have been installed before continuing. 

• Microsoft Outlook version 2003 or higher; 
• Time version 2013; and 
• Internet Explorer version 8.0 or higher and a connection to the internet in order to publish to web pages properly. 

They do not publish properly using another browser such as Netscape. 

 Note 

• The Exchange server is required only if synchronization is being done to or from the Outlook public folders that are stored on 
a server. 

• Today does not operate with versions of Outlook prior to version 2003. 
• According to Microsoft, activeX controls and add-in (COM) DLLs that are written for 32-bit Office do not work in a 64-bit 

process 

Order of installation 
Using Today to set up forms and synchronize Time with Microsoft Outlook requires that all three 
applications be installed on your computer. You must install the components in the following 
order: 
 

New Users Existing Users 
Microsoft Outlook 2003 or higher; 
Time 2013; 
Today 2013. 

Time 2013; 
Today 2013. 

 

When installing Today, version numbers of the two products are checked. If you have installed an 
earlier version of Time that does not correspond to Today's version, a warning is displayed to 
notify you to update Time. Today cannot be installed until the update is done. 
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 Note 

• Exchange server is required only if synchronization is being done to or from the Outlook public folders that are stored on a 
server. 

• Install Today 2013 in a different directory than the one used for the previous version of Today.  
• Ensure that you have Internet Explorer version 5.0 or higher and a connection to the internet in order to publish web pages 

properly. Today works inside MS Outlook if Internet Explorer is embedded. In Outlook the only browser that can be 
embedded is Internet Explorer. 

• Today will not operate with versions of Outlook prior to version 2003.  

Installing Today 
MS Outlook must be closed. Please make sure no other programs are running before you install 
Today. Disable any virus-checking software until you have finished the installation. Most virus-
checking software interferes with the copying process done by the installation program. 

The Today program has to be installed on each workstation that will be accessing the Today 
folders. When installed, all the components to run the program will be available on that 
workstation. 

Installing Today is a simple process. The installation program sets up all the necessary files, 
program groups, and icons needed. 

 Note 

• During installation please read each window carefully before continuing. 

To install from CD 
1. Insert the CD into your CD-ROM drive. 
2. Use Explorer to access the Today folder.  
3. Double-click the SETUP.EXE file. This starts the installation.  
4. Follow the instructions on the screen.  
5. When you reach the Setup Type window, select the setup type you prefer. If you select  

• With synchronization, the program is installed with all available options. This is recommended for users using personal 
folders or users using public folders who perform synchronization. 

• Without synchronization, the program is installed with the minimum required options only. This is recommended for users 
using public folders who will NOT perform synchronization. 

After you install Today refer to any existing README files for information on last minute changes 
and environment settings. To do this, double-click the README icon in the program group from 
which you installed Today. 

Troubleshooting: Did you encounter problems? 
• Make sure that you have write privileges in the directories specified for the installation and 
• Make sure that there is enough free disk space on the hard drive. 

Starting and Exiting Today 

To start Today 

There are three ways to start up Today. 
1. On the Windows desktop, click the Today icon. 
2. In Microsoft Outlook, click the Today button: 

[Outlook 2003]: Located near the top of your screen. 
[Outlook 2010]: Located in the Add-Ins tab on the Outlook ribbon. 

3. In Time, click the Tools menu and select Today Sync. 

To exit Today 
• From Microsoft Outlook, click the File menu and select Exit and Logoff. 
• From Time, select File  Exit or type Alt+F4. You will exit from Time as well. 
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Troubleshooting: The Today button in Outlook 

After installing Today on your computer, please ensure that the Today button in MS Outlook is 
working. For example, the button may not work if MS Outlook was open during installation of 
Today. 

[Outlook 2003] If the button is not working, you should: 
1. Click the Tools menu and select Options  Other tab. 
2. In the General section of the Other dialog, click the Advanced Options button. 
3. Click the COM Add-Ins button. 
4. Check the Add-In box. 
5. Click OK until you exit the Options dialog and return to MS Outlook. 

[Outlook 2010] If the button is not working, you should: 
1. Click the File tab and click Options. 
2. Click Add-Ins from dialog options. 
3. Select COM Add-ins from the drop-down menu for Manage and click Go. 
4. Ensure CaseWare AddIn is selected. 

 Note 

• If the colors of your Today button are not right, try setting your display properties to High color (16 bit). To change the colors, 
click the right mouse button on your desktop and select Properties. Then click the Settings tab. 
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Setting up Today in Outlook 
In order to set up Today to synchronize information between Time and MS Outlook, you must 
follow these primary steps without omitting any procedure. The configuration must be done in 
Microsoft Outlook as the Outlook defaults do not match what is needed with Time. 

The procedure is the same whether you are setting up Today for the first time or upgrading from 
a previous version. 

New user 

The following is an overview of the steps a new user completes to set up the Today file. 
1. Open Today 2013. 
2. Select the program folder where the Time 2013 program is installed. 
3. Click the Today Setup tab, and complete the following: 

a. Enter a title for your Today 2013 folder.  
b. In the Today folder destination field, enter the path to the folder. This can be the same path as used in 

the previous version. 
You can also browse to select the location of the folder or to set up a new folder. If you create a new 
folder, then Today is set up in a subfolder of that folder. 

c. In the Web Page Destination field, enter the full path or browse to the directory where Today can store 
web pages. By default the folder should be in your new Time 2013 program directory. 
If you are using Today in public folders, enter the file server path that is shared by all staff. 
Refer to the topic Public Folder Setup -> File locations for more information. 

d. Click Setup. 
4. If applicable, copy contacts already in Outlook to Today. 

a. Copy Contacts to the Clients folder or Contacts folder in Today. 
b. For each of these contacts, enable synchronization 

Note: If you copy an Outlook contact to a client form in Today, you need to enter a client ID. 

If you are synchronizing the data with records in Time: 
1. Prepare the Time data file. 

a. Set up protection in Time 2013. 
b. Ensure that the Time file is not compressed. 

2. Synchronize the data from Time into Outlook for the first time. In Time 2013, use the command Tools ->Today 
Sync. 

Each of these steps is detailed later in this section. 

Upgrading from a previous version 

 Note 

• There is no upgrade procedure from Today 2011 to 2013. The setup procedure is the same as setting up Today for the first 
time when you are upgrading from a previous version. You need to convert your Time 2011 files to Time 2013, and then 
synchronize data from Time 2013 to Today 2013. 

1. Set up the forms to display the Time data under a newly-titled folder. 
2. Convert the forms from the previous version to the new version.  
3. Delete the old forms. 
4. Synchronize data from Time to Today. 

Refer to the detailed instruction in the section "Updating from a previous version of Today". 

 Note 

• Synchronization will not be successful if there are spaces or invalid characters in the Time data file name. See the topic 
Troubleshooting Synchronization later in this chapter. 

Are you using Today in public or personal folders of Outlook? 

Whether to install Today to the public folders or personal folders in Outlook depends upon how 
you and your firm manage your client database(s).  
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• If you share your client database and you want to manage it centrally, put it on a server on the network. Follow the 
information under Public Folder Setup. 

• If you want to maintain client records separately from those of the firm, set up Today  in your Outlook personal 
folder. Read the section titled Personal Folder Setup. 

Public Folder Setup 
If you are using Today in public folders, the Today program has to be installed on each 
workstation that is accessing the Today forms in public folders, even if Today is to be used only 
with Public folders. 

After installation of the software, only one person needs to set up the Today forms and HTML 
files in the public folder of the Exchange Server. This must be a staff member with administrative 
rights. Today forms are set up by going to the Today setup tab. See the instructions "Setting up 
Forms in Today". 

Setting up Today on the Exchange server enables all the Outlook users to use the functionality of 
Today on the public folders as they do in personal folders. This means all users with the 
applicable protection rights are able to access the Today forms in public folders and proceed with 
any applicable operations. 

The Today forms have to be set up only once and this can be done from any workstation. Once 
the forms are set up, no other set up is needed until it's time to upgrade to a new version of 
Today. 

All users are able to view and access the forms in the public folders according to rights they are 
granted in the Exchange Server. 

Exchange Server Rights 

All users are able to view and access the forms in the public folders according to rights they 
are granted on the Exchange Server. The minimum "right" needed on the Exchange server to 
be allowed to synchronize between Time and Today is the ability to "write (create items)".  

To check your administrative rights 

Right-click the public folder where you want to set up Today. Click properties and check the 
permission tab. If you don't have the necessary rights, ask your Exchange Administrator. 

If you don’t see the permission tab, ask your Exchange Administrator. 

File locations 

Today builds on both the storage features of Exchange Server and a Web interface, so the 
administrator must specify two locations for Today files: 

In Field Enter 
Today folder 
destination 

A Microsoft Exchange Server public folder. This is where you will store your data 
using Outlook. 

Web Page 
Destination 

A file server that is shared by users. Because Today forms are Web pages, they 
need to be stored on a file server so that all users can see the web interface (digital 
dashboard). The shared file server is where the Home Pages folder must be. 

Personal Folder setup 
Forms in personal folders can be accessed and viewed only by the owner of the folders. Often 
the partners maintain their own client records separately from those of the firm. In that case, each 
partner should set up Today in his personal folder and synchronize those records separately. 

The setup procedure is basically the same as for Public Folder setup using a local location for 
storing web pages.  

When Today is used only in personal folders, the sections covering exchange server rights, file 
locations, and verifying the home page path are not applicable. 
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1. Setting up forms in Today 

In order to be able to synchronize between Time and Outlook, it is necessary to create new 
folders in Microsoft Outlook to store your information from Time. The Setup function in Today 
creates the necessary folders and forms for you depending upon what's in Time. You do not have 
to worry about creating your own Outlook forms. 

Note - setting up forms when upgrading from a previous version 

The new version's forms must be set up in a different Outlook folder from the previous version's 
forms. Having them in different folders allows Today to detect the forms set up in the previous 
version automatically for conversion. Refer to the section "Updating from a previous version of 
Today". 

Setting up the forms in your folders 

After installation of Today a " Today " button is added to the Outlook toolbar automatically. 
1. Click the Today button. (If the Today button does not appear or fails to work, see the troubleshooter titled 

"Troubleshooting the Today button".) 
2. Click the Browse button to locate and select the Time program folder. After you click OK its name is entered in 

the field provided and has the format  
"C:\Program Files\CaseWare Time 2013" or "C:\Program Files (x86)\CaseWare Time 2013". 

3. Click OK. 
4. From within the Today dialog, do the following: 

a. Click the Today Setup tab. 
Refer to the following illustration for steps 4 b, c and d. 

 
b. Enter the title of your Today in the first field. You may change this as desired. Note that if you are 

updating from a previous version of Today, it cannot have the same name as the previous version's 
folder. 

c. In the Today folder destination field enter "\Public Folders", "\Personal Folders" or "\Mailbox", which 
ever is applicable.  

You can browse to select the location of the folder or to set up a new folder. (The MS Outlook Select Folder 
dialog appears.) If you create a new folder, then Today is in a subfolder of that folder.  
Note: Forms may not be set up directly in Microsoft Outlook's special folders (Inbox, Outbox, Drafts, 
Calendar, Journal, Contacts, Deleted Items, Notes, Sent items, Tasks, Personal Folder). You must create a new 
folder.  

d. Specify the Web page destination in the last field. By default the location entered, is Today's program 
directory.  

• For public folder setup, enter the path or browse to the applicable folder on the file server, a network drive, to which 
all users have full access. Refer to the topic Public Folder Setup -> File locations for more information. 

• If you are using Today in the personal folders of Outlook, you do not need to change the path. 

5. Click Setup. 
6. Click Finish to set up the forms. 
7. When the forms are set up, click Close. 

The selection of folders created is dependent upon what is in Time. The following folders are 
created automatically in the new Today folder: 
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 Notes 

• When user profiles or roaming profiles are set up in Outlook, proper permissions must be provided for the Today folders on 
the Exchange server and the file server where the HTML files (web pages) are published in order for the user to access the 
forms properly.  

• In addition, if you have more than one user profile in Outlook or if more than one person uses the same computer to access 
Today, then you need to ensure proper permissions are set up for each user profile to allow access to Today both locally and 
over a network.  

• You can change the name of the Main Folder, Today, but you should not change the names of the subfolders that were 
created automatically. Any changes to the names may result in unsuccessful synchronization. 

• If you want to have the Today folders in both your Personal and Public folders you should set up the forms in both folders by 
following the above procedures each time. 
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 Related Topic 

• With the forms configured, you can set each up to interact with a tasks list, schedule, meetings list, knowledge base or files. 
Please refer to "Viewing tasks in the Activities tab of the applicable Client, Contact or Staff folder" for more information. 

After setting up the forms, the following should be done: 
1. Verify the home page path in each form. 
2. Ensure each user can see the Today Home Page. 

Verifying the home page path in each form 
1. In Outlook, open the public folder. The forms are set up under the folder Today that you created.  
2. For each Today folder in the public folder: 

a. Right-click the folder or form. 
b. Select Properties and click the Home Page tab. 
c. Verify that the path in the Address field is pointing to the correct location for publishing webpages from 

Today. This is the folder you selected during setup in the Web Page Destination field. 

2. Copying contacts already in Outlook (OPTIONAL) 

a. Copying Your Contacts 

When there are existing client contacts in the Outlook contact folders, they can be copied to 
the Outlook Client folder that was created while setting up forms. Once copied, these client 
contacts can be synchronized to Time. 

Copying must be done using the Today dialog Copy Contacts tab. Copying and pasting within 
the Outlook explorer does not copy the forms correctly. 

To copy Outlook contacts to the Today Clients folder: 
1. From Today dialog click the Copy Contacts tab. 
2. Click the browse button to select the Outlook contact folder you are copying from. 
3. Click the browse button to select the Today Client folder to which you are copying contacts (that is, the Clients 

folder under Today). 
4. Click Copy to start processing. 

You will get a dialog telling you to make some modifications to the contacts just copied. See step b below. 
5. Close the Today dialog. 

To copy Outlook contacts to the Today Contacts folder: 
1. From Today dialog click the Copy Contacts tab. 
2. Click the browse button to select the Outlook contact folder you are copying from. 
3. Selet the Contact folder under Today. 
4. Click Copy to start processing. 

You will get a dialog telling you to make some modifications to the contacts just copied. See step b below. 
5. Close the Today dialog. 

b. Enabling synchronization and entering a client ID 

The contacts copied to the Clients folder require modification before synchronizing to Time: 
1. Click the Clients folder in the Today folder. 
2. Click the Phone List view. 
3. Sort first by the Customer ID column to and then by the Type column to identify which clients have no client ID 

and/or are not active. 
4. For each client that either has no ID or is not active: 

a. Open the client record. 
b. Click the Time tab. 
c. As applicable, in the Type field select Active. 
d. As applicable, assign a unique client number to the client. 
e. Click the Save and Close button. 

The contacts copied to the Contacts folder require modification before synchronizing to Time: 
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1. Click the Contacts folder in Outlook under Today. 
2. Open the Contact record. 
3. Click the Time tab. 
4. Each Contact must have an entry in the “Last Name” field. You can fill in the other fields as applicable. 
5. To enable records for synchronization, ensure the checkbox for “Do Not Synchronize” is unchecked. 

 Note 

• Client, client contact, and group ID numbers cannot be changed once entered and saved. If you make a mistake, the records 
must be re-entered in Time. 

• For further information please refer to the Time User Guide. 

 

3. Preparing the Time File 

Setting up Protection 

We recommend that you activate file protection in Time as only certain staff should have rights 
to carry out synchronizations. Typically these people would include the supervisor, the partners 
and other high-level staff. Synchronization rights may be assigned separately for synchronizing 
data from Today to Time and from Time to Today. When synchronizing data, the Today 
personal folder of Microsoft Outlook uses the file protection system in the Time file. 

To enable synchronization, turn file protection ON in your Time file. Therefore, the user must 
be a member of a Time Protection Group with access rights set to synchronize from Time to 
Today or from Today to Time. This is set up in the Tools | Protection | Protection Setup. 
Under Available groups, select a group and click the Properties button. When the dialog 
opens, click the Rights tab and select Tools: Today Sync.  

If you are the supervisor, you have rights to all areas, but for any other users, rights must be 
activated.  

In addition the user must have rights to set up clients, staff or groups. Client and group setup 
access rights can be assigned in the detailed level. Access rights can be assigned to "All 
clients and groups" or to "Own clients and groups". For further information on Protection, 
please refer to the Time Help Topic Protection. 

 Note 

• To synchronize to public folders, the MS Outlook administrator has to set up the proper protection in Outlook as it has 
independent protection from Time.  

4. Synchronization 

Activating the synchronization from Time 

In order to be able to synchronize between Time and MS Outlook, first you must follow the 
instructions under "Setting up Today ". 
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1. Open the Synchronization dialog by clicking Tools  Today Sync.  
You will go directly to the Today Synchronization tab of the Today dialog. 

 
2. Select the direction of synchronization: 

From Time to Today OR 
From Today to Time. 

Note 

• Usually your first synchronization is from Time to Today. We recommend that subsequent synchronizations be carried out 
from Today to Time. 

3. Select the Time data file from or to which you are going to synchronize. Click the browse button to navigate to 
the data file and select the file <filename>.ar. 

Note 

• Synchronization will not be successful if there are spaces or invalid characters in the Time data file name. See the topic 
Troubleshooting Synchronization later in this chapter. 

4. Select the Outlook folder where you are keeping your information from Time. Usually this is called Today and it is 
located either in your Public or Personal folders. Click the browse button to find it and then click OK. 

5. When synchronizing from Today to Time, the Options button is active allowing you to select options for timing 
the synchronization process. Click the button to set these options. 

Note 

• This is not available for the first synchronization as you are importing all records from one package to the other during this 
first synchronization. 

6. Click the Process button when you are ready to process the synchronization as set up. The applicable selected 
data from the originating software is copied into the other package. 

7. When the process is complete, close the dialog. 

 Tip 

• Start with small files first to see this process. Large files can take quite a bit of time. 

Activating the synchronization from CaseWare® Today 
1. Open the Synchronization dialog by clicking the Today button. 
2. A Select dialog will appear. Click the Browse button to locate and select the Time program folder. After you click 

OK its name is entered in the field provided and will have the format "C:\Program Files\Time". 
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3. The Today dialog appears with the Today Synchronization tab selected. 
Select the direction of synchronization: 
From Time to Today OR 
From Today to Time. 

Note 

• Usually your first synchronization is from Time to Today. We recommend that subsequent synchronizations be carried out 
from Today to Time. 

4. Select the Time data file from or to which you are going to synchronize. Click the browse button to navigate to 
the data file. 

Note 

• Synchronization will not be successful if there are spaces in the Time data file name. 

5. Select the Outlook folder where you are keeping your information from Time. Usually this is called Today and it is 
located either in your Public or Personal folders. Click the browse button to find it and then click OK. 

6. When synchronizing from Today to Time, the Options button is active allowing you to select options for timing 
the synchronization process. Click the button to set these options. 

Note 

• This is not available for the first synchronization as you are importing all records from one package to the other during this 
first synchronization. 

7. Click the Process button when you are ready to process the synchronization. 
8. The Log in window will appear to prompt you for your Time user ID and password. Enter your ID and password 

and click OK. 
The synchronization process will begin. All the data from the originating software is copied into the other 
package. 

9. When the process is complete, close the dialog. 

 

Options available when synchronizing from Today to Time 

Each time that you carry out a synchronization, all records in the Staff and Contacts folders are 
synchronized. They are relatively small databases that take little time to update. However the 
Clients database is full of many details including all the data in the sub-folders of the Options 
folder. Updating all of them will take a great deal of time, particularly if you have a lot of clients. 
When synchronizing from Today to Time, you have the option to synchronize only those client 
records that have been altered since the last synchronization. This cuts down on the number of 
records being synchronized and therefore the time needed. 

To help you identify which records need updating, each record in the Outlook client folder keeps 
track of the date and time last modified. Every time a modification is made to a client record, the 
modified date and time is updated. 

Viewing record modification dates in Microsoft Outlook 

Each record in the Outlook client folder has a modified date and time. Every time a 
modification is made to a client record, the modified date and time is updated. When 
synchronizing, you can select recently modified records. 

To view the last modified date for the records in the Client folder 
1. Select the Client folder from Today Explorer and under "Options" click Customize Current View. 
2. In the Advanced View Settings dialog, click the Columns button. 
3. In the Show Columns dialog, select "Frequently-used fields" from the drop-down filter for available columns. 
4. Select "Modified" from the Available fields and click the Add button. Use the Move Up and Move Down buttons to 

position it in the order desired. 
5. Click OK to activate your changes. 
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6. Click OK to exit the Advanced View Settings dialog. 

 

To synchronize just those clients changed over a specific time period 

Once you have carried out the initial synchronization to set up your folders and data in 
Microsoft Outlook, you can synchronize only those client records that have been altered since 
the last synchronization. This cuts down on the number of records being synchronized and 
therefore the time needed. 

1. In the Today Synchronization dialog, click the Options button. 
2. Check the Set Synchronization box to activate the timing option. 
3. In the "Synchronize Clients" section, select the date and time from which you would like to do the 

synchronization. 

 Note 

• Remember that if this is the first time you are synchronizing from Today to Time, the default is the current date and time as 
you must synchronize all records. You must change this date to the date you last modified your clients' records. 

Refer to the "Last synchronization date and time" field and the modification dates in the Clients 
folder to set the new From date and time. 

Troubleshooting Synchronization 
1. First check the synchronization log for any errors or items that were omitted from the synchronization process. 

Look for the log file in your documents and settings folder. The path is 
C:\Documents and settings\username\Application Data\Today\log\ 
A new file is saved each time that you synchronize. The file is named with the format yyyymmdd___.log and can 
be opened and printed with Notepad. 

2. If Today is set up in public folders, check the user's permissions for those folders and subfolders on the server. 
Read Permissions for public folders. 

3. Synchronization cannot occur if the user does not have full rights in Time to set up records and run a 
synchronization. To check the user's rights, launch Time and click Tools | Protection | Protection Setup and 
then under Available groups, select a group and click the Properties button. When the dialog opens, click the 
Rights tab. The help topic for the Rights tab has links to explanations of all of the protection rights.  
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4. Ensure that you have completed all the instructions for Customizing Today. 

Permissions for public folders 

In order to synchronize Today with Time, a user must have full rights to all Today folders on 
the public server, including subfolders. Even if a user is synchronizing only client information, 
he or she must have full permissions to the staff, projects, schedule and all other folders in 
Today.  

Giving rights to a user to modify a root folder level may not automatically grant permissions to 
its subfolders. Make sure that the user has full rights to each subfolder. 

Updating Microsoft Outlook and permissions 

Following installation of any update to Microsoft Outlook, check the public folder permissions. 
During the upgrade of Outlook, the update may override previously-set permissions. 

Avoiding obstacles when synchronizing 
• If you update records in either Time or Microsoft Outlook, you must synchronize again to get the updates into the 

other software. After you have done the initial synchronization to port your Time data and folders over to Outlook, 
make it a habit to pick one of the packages where you do all updates and then synchronize regularly to the other. 
• It is advised that only the supervisor should have rights to carry out a global synchronization on all the data. 

Each partner should be given rights to update only the clients assigned to her or him. Synchronization rights 
may be assigned separately for synchronizing data from Today to Time and from Time to Today. No other 
users should be granted synchronization rights in order to protect the integrity of the data and ensure that the 
method of updating is uniform. Rights can be set up in Time in the Tools | Protection | Protection Setup. 
Under Available groups, select a group and click the Properties button. When the dialog opens, click the Rights 
tab. 

• Review the topic Troubleshooting the Today button. 

When synchronizing from Time to Today or from Today to Time, the synchronization process 
• Always check the "last modified date" of the records; 
• Compares the "last modified date" of the record in the Time database versus the "last modified date" of the same 

record in the Today form. The record with the later "modified" date overwrites the old one. 

The following changes should be done in Time and then synchronized to Today 

Modifying records in some areas of Time can have a many-step or complicated process that 
can affect several areas of Time. Some of the areas affected do not synchronize to Today. 
Therefore, please carry out the following changes in Time only and then do a synchronization 
from Time to Today. 

 Assignment of staff, partners and managers to clients; 
 Assignment of partners and managers to staff; 
 Change of Client or Staff numbers. In particular, do not change them in the list views 

of Today. It will cause synchronization problems with Time. If you want to change an 
identification number, it is best to open Time and create a new record there and then 
deactivate the existing record; 

 Deactivation of staff or client records. This cannot be updated from Outlook.  
 Changes of existing clients into groups when the client has transactions outstanding.  

If you do this from Today, you will get an error message and an email is generated 
and sent. We suggest that you create a new group if required and move the 
applicable client into that group. 

 Codes in the Administration | Options forms of Today. 
 Modifiation to the existing codes in the Administration | Options forms.  
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Troubleshooting: Reference information in the Microsoft Knowledge Base 

The following are the links to some articles about Outlook errors and limitations. 

Summary or Symptoms Please Read Microsoft Support Article 
You get an error message stating there is an 
invalid page fault or when trying to send email, 
you receive an error message that states "This 
program has performed an illegal operation and 
is shut down."  

OL2000: Invalid Page Fault in Module Mso9.dll 
(http://support.microsoft.com/support/kb/articles/Q241/
8/17.asp) 

When you try to create a reference in Microsoft 
Visual Basic, one of the following problems 
occurs depending on the program you are 
running.  
Microsoft Word 
This program has performed an illegal 
operation and is shut down.  
If you click Details, an error message similar to 
the following appears: 
Winword caused an invalid page fault. 
When you click Close, the program shuts down.  
Microsoft Excel 
Can't quit at this time.  
When you click OK, the program shuts down. 

OFF2000: Program Shuts Down After Referencing 
Document 
(http://support.microsoft.com/support/kb/articles/Q217/
7/24.asp) 

Outlook provides a new feature that allows you 
to do a mail merge with your contact list from 
within Outlook. In previous versions of Outlook 
a mail merge was done in Microsoft Word. 

OL2000: How to Mail Merge Using Contacts 
(http://support.microsoft.com/support/kb/articles/Q192/
2/58.asp) 

When you use the Microsoft Outlook Address 
Book as a data source for a mail merge in 
Microsoft Word, the Outlook Contact records 
are converted into a file named 
~~~_virtual_file_~~~.olk.  
Some Outlook fields are not available in this file 
and some field names are a bit different from 
what they are in Outlook. This article describes 
the Outlook fields available to Word Mail Merge 
and lists those that are not available. 

WD2000: Field Differences Between Outlook and 
Word Mail Merge 
(http://support.microsoft.com/support/kb/articles/Q197/
7/16.asp) 

Resources and answers to commonly asked 
questions about creating custom solutions with 
Outlook forms 

OL2000: Questions About Custom Forms and the 
Outlook Solution 
(http://support.microsoft.com/support/kb/articles/Q146/
6/36.asp) 

Troubleshooting Public Folders 

If you encounter problems with Today forms in public folders, first check the user's rights in the 
public folders and subfolders of Today.  

Next, if the permissions are fine, check name of the folder. It may need to be specified better. 

The administrator with permissions to change public folders should do the following: 
1. First check the properties of the folder where the problem occurred. Right-click the folder and select Properties. 

Take note of the folder name. You need it in step 8. 
2. Open the folder where the problem occurred. 
3. Select the form that had problems and double-click to open it. 
4. From Tools menu, select Forms  Publish Form As. 

 
[Outlook 2010 users only] 
The Publish Form As option is available in the Developers tab on the Outlook Ribbon. If this tab is not available 
you need to enable it in Outlook: 

a. Click Files and select Options. 
b. Click the Customize Ribbon option. 
c. Select Main Tabs from the customize drop-down. 
d. Select the checkbox for Developer and click OK. A Developer tab should now appear on the Outlook 

Ribbon. 
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Access the Publish Form As option as follows: 
a. Click the Developer tab and select Choose Form. 
b. Navigate to the form using the Look In drop-down menu and select the applicable form from the 

populated list. Click Open. 
c. In the Outlook dialog displaying the selected form, click the Developer tab. 
d. Select Publish | Publish Form As. 

 
5. In the "Look in" field, select "Organizational Forms Library", the first selection in the list. 
6. Locate and highlight the form that had the problems, e.g., "TimeTask". 
7. In the "Form name" field, change the name. One suggestion is to add the version number to the end of the 

name, e.g., "TimeTask2013". 
The format of the name has to be Today+ "FolderName" + Version #. 

8. Make sure there is a name in the "Display name" and that it contains no version number. e.g. TimeTask. If you 
need to re-enter it, use the name noted down in step 1. 

9. Click "Publish" button to publish the form. 
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Troubleshooting form setup 

If you are not able to see Today web pages 

When you click a Today folder and nothing shows up in the window, please do the following:  
1. Right-click the folder. 
2. Select properties and then click the Home Page tab. 
3. Make sure "Show home page by default for this folder" is checked. 

 

If you get an error message saying the web page could not be found 

Symptom 

The following error message is received:  

The web page could not be found. This error could have been caused by a bad or 
misspelled URL; following an invalid link; or our network connection and/or transient 
conditions on the internet. Please contact the folder's administrator. 

Causes 
• The file name, the file extension or the folder containing the web pages has been renamed; 

OR 
• The folder containing the web pages has been removed or has been moved since setup.  

Solution 

Make sure you are accessing the correct location of the web pages. To verify the path: 
1. From one of the affected forms, open the properties by right-clicking the form.  
2. Click the Home Page tab.  
3. Ensure the location of the web pages is correct. The directory should be one that all users have access rights to, 

usually on a shared file server. 
4. If this is not the case, ask the user to check with his administrator to locate the proper directory and change the 

path accordingly.  
5. Repeat this process for all folders that are not working. 

The Today Interface 
 Today uses the Microsoft Digital Dashboard web interface in the Today folder. 
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Digital dashboards enable you to access the information that you need -- personal, team, 
corporate, and external -- from a single, easy-to-use interface. With the digital dashboard you can 
access documents, business applications, websites, email, calendar and task lists with ease from 
the same screen. You get an integrated view of your company's knowledge sources on your 
desktop, enabling better decision making by providing immediate access to key information. 

The digital dashboard is intuitive to use and highly customizable. You can decide what 
information to display on it by selecting from a list of components. To rearrange how information 
is displayed just click and drag. 

Open the Today folder and click any of the sub-folders in it. You'll see the digital dashboard and 
the options for changing each folder's look to suit your needs. 

Customizing the look of Today - The Navigation bar 

Options 

On each folder page, you can do the following: 

• Add a new item 
• Set categories 
• Customize current view 

Add a new item: 

To add or modify an item, open the form and enter the information or make changes there. 
1. Under Options, click New …; 

OR 
When looking at a list view, double-click the field just under the headings that says "Click here to add a new …";  
OR 
In list view, double-click the blank line just below the last record. 

2. In the Name box, type the name of the new item. 
3. Enter information in other boxes as appropriate. 
4. Click Save and Close. 

Note 
• To modify any existing item, double-click the name to open the record and make changes. 

Set categories 

A category is a keyword or phrase that helps you keep track of items so you can easily find, 
sort, filter, or group them. Use categories to keep track of different types of items that are 
related but stored in different folders. Categories also give you a way to keep track of items 
without putting them in separate folders. For example, you can keep business and personal 
tasks in the same task list and use the Business and Personal categories to view the tasks 
separately. 

This is a standard Outlook feature. Microsoft provides a basic list of categories to get you 
started, but you can add your own as needed. For detailed instructions, refer to the MS 
Outlook Help. 

Tip You can assign more than one category to an item. Use semicolons (;) to separate the 
category names. 

[Outlook 2003] To assign a category to an item: 
1. Select the item to which you want to assign a category. 
2. Click Set Categories. 
3. In the Categories dialog box, do one of the following: 

• Select a category from the Available categories list. 
• Type a new category in the box above the list. 

 

[Outlook 2010] To assign a category to an item: 
1. Select the item you want to assign a category to. 
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2. Click Categorize. 
3. Click All Categories. 
4. Select a category or add a new one. 

Customize current view 

Use this to change the view in a folder to match your personal preferences. You can either 
switch from the active view to another standard view, or stay in the active view and reorganize 
the information. For example, you can group, sort, filter, add or remove fields, and change 
fonts and other formatting. 

Tip You can sort items by clicking the heading of the column by which you want to sort. If the items are displayed in 
groups, they are sorted within those groups. 

Setting the default view 

Each folder has a default view which is the first layout you see when you click that folder. To 
change the view that is the default, do the following:  

1. In the Today explorer, click the Customize folder. 
2. In the section Default Views,  

a. Click the Current view in folder drop-down list and select the folder to change. 
b. Click the shows list and select the view that you want. 
c. Click the Save Changes button. 
d. Close the Customize Page. 

3. Navigate to the applicable folder and verify it shows the correct layout view. 

 
Show Me 

You can set each folder to have one of several looks. Look under the "Show Me" navigation on 
the left to see the views available. 

The following views are common to all folders. 

Click To 

Grouped by _______ Group the items by type of group chosen. 
Grouped by category Group together all items belonging to the same category. If 

an item belongs to more than one category, it will appear in 
the group for each category. 

All items To remove any groupings and see the items in a simple list. 
Editable ______ view Change information for an item in this view by clicking the 

information you want to change and then typing over it. To 
group items by a column, drag the column heading into the 
designated area above the headings. 

 
Find 

You can search quickly for messages, records and documents stored in Today. To search for 
an item in a folder:  

You can search quickly for messages, records and documents stored in Today. To search for 
an item in a folder: 

1. Click the folder to search and locate the Find function on the left navigation. 
2. In the Find box, type the text you want to locate. In each folder, Today focuses the search on a different field 

which is noted in brackets. For example, in the Clients folder, the name field is searched by default. To search by 
another field in the folder, use the Advanced Find. 
Note: You can change the default search category. See the topic "To change the default search for a folder".  

3. To view items that meet the criteria, click Find Now. 
4. To restore the previous view, click Clear Search. 

Tip To control the search further, click Advanced Find. Click the Advanced tab, and then select the options you 
want. 

Search for items and files using Today form fields 
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1. Click Advanced Find.  
2. Click the Advanced tab. 
3. Click Field. 
4. Point to the field set you want, and then click the field you want to use in the search criteria. Fields specific to 

Today are under the category whose name begins with "Time". 
5. In the Condition box, click the condition you want to use with the selected field. 
6. If the condition requires a value, enter the value you want the field and condition to meet in the Value box.  
7. Click Add to List. 

To add additional criteria, repeat steps 3 through 7.  

Note  
• When setting search criteria, if you select more than one search option, only the items that meet all of the search criteria are 

found. However, if you use the same field to set multiple criteria, items that meet one criterion within that field are found. 

To change the default search for a folder 

Each folder type in Today has a default search category. For example, when the Clients folder 
is searched, the default key it uses is by Name. This can be changed. 

1. Click the Customize folder. 
2. Locate the selection Default Find Now. 
3. Choose the folder to change. 
4. Click the Shows field and select the category for the default search. 

The Short Cut Buttons 

Just above the navigation bar, you'll see buttons that take you quickly to the Tasks, Schedule 
or Administration folders, the Customization page, the support website (from the Today home 
page only), or the Today Help system. 
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The Today Folders 
Using the buttons at the top of the page, you can view any of the following folders: 

• Home Page 
• Project Workspace 
• Performance Metrics 
• Our Clients 
• Our Contacts 
• Contact Companies 
• Staff Members 
• Meeting Room 
• File Room 
• Knowledge Center 
• Training Center 

 
Information in these folders is presented at the group level. Each folder displays unique 
information and synchronizes with Time differently. 

The Files, Knowledge, Metrics, and Training folders are provided to let you post information for 
your team. These folders do not synchronize with Time but they are very useful.  

Folders can use Outlook Forms to store additional information related to contacts, contact 
companies, clients and staff members. Certain fields within these forms can be synchronized with 
their respective fields in Time. Each form uses a tabbing view to display categories of 
information. Your view of Today commands is different for different versions of Outlook. 

[Outlook 2010 View] 

 

The Today Home Page Folder 

The Today home page gives you a quick overview of the contents entered in MS Outlook and 
their status. It shows the number of unread items in each folder. It also displays news about your 
company and links to additional information. 

The Home Page is your starting point. Log in to it and get a quick view of your calendar, tasks to 
do, upcoming events and company news. It's organized into areas frequently used but you can 
arrange it as you want. To do so, click the "Customize..." page. Settings for the News area can be 
changed in the "Administration" folder. 

Finally, you can hide or show the contents of each area by clicking the button at the right end of 
each title bar. 

Customize Folder 

Use this folder to choose the information presented on the Today home page and the format of 
that information.  

You can 
• Set Today to be the page you see when you launch MS Outlook;  
• Choose folders to be expanded when you launch Outlook;  
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• Select the number of days to be shown in your Today schedule and select which calendar in Outlook to use when the "My 
Calendar" link is clicked in Today;  

• Filter the tasks shown on the home page;  
• Set the default layout to see when you click a Today folder; 
• Set the default category to search in each folder type; 
• Include Today in your Favorites; and 
• Add Today to your shortcuts bar. 

Be sure to click "Save Changes" at the top right corner of the Customize page to apply any 
selections made. 

Clients Folder 

The Clients folder displays information for your company's clients. 

On the Clients home page, you will see the summary listing of all the clients in the database. 

Show Me 

In addition to the standard folder views, the following views are available in the Clients folder: 

• Phone List: List clients along with their phone numbers and other basic information. 
• Address cards: View basic information about clients in an address-card format. 
• Detailed address cards: View detailed information about clients in an address-card format. 
• Client groups: Group together clients that are assigned to the same client group. 
• Clients grouped by type: Group together clients that belong to the same type such as active, inactive, personal, 

prospect, referral, or suspended. 
• Clients grouped by category: Group together clients that belong to the same category. 
• Clients grouped by follow-up flag: Group together clients that are flagged for follow-up. 

When you double-click a client record, you will open a dialog that looks very much like the 
Clients dialog in Time, including tabs dividing the client information into categories. 

General tab 

Based on the Microsoft standard form for contacts, this tab provides general information 
regarding the client. For more information on the features available, refer to the MS Outlook 
Help. 

 
 
Field 

 
 
Description 

Synchronizes with Time 
Clients Setup dialog 

Full name Full name of the person to contact. Click the button for a 
guide to entering new clients. 

Yes. First and last names 
are synchronized to the 
attention tab of the Client 
setup dialog. 

Job Title Job Title of the person to contact.  No. 
Company Company Name Yes. This name 

synchronizes with the 
Client name 
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Field 

 
 
Description 

Synchronizes with Time 
Clients Setup dialog 

File As You have the option display the record on the Clients 
home page in one of several ways. Click the look-up 
button for a selection of formats. 
To set the default selection the following steps must be 
taken: 
[Outlook 2003] 
1 From the Tools menu select Options 
2 On the Preferences tab, click Contact options. 
3 In the Contact options dialog, select Company from the 

listing for Default "File As" order.  
[Outlook 2010] 
1. From the File tab select Options. 
2. Select the Contacts option. 
3. Under Names and filing, select Company from the Default 

“File As” order drop-down. 

No. 

Business, Home, 
Business Fax, Mobile 

The names of these fields can be selected and changed 
using the look-up buttons. 

Yes. To the fields in 
Address tab. 

Address Mailing address. Use the look-up button to set the 
location of the address. Click the check box below to set 
an address as the default. 

Yes. To the fields in 
Address tab. 

Email Email address. You can store up to three different email 
addresses per client. The book button at right lets you 
select from your Outlook address book as well. 

Yes. To the field in 
Address tab. 

Web page address Web page address of the company Yes. To the field in 
Address tab. 

Notes area Enter any additional information as needed. No. 
Contacts Click to select one or more people in your contacts list 

who are associated with this client. 
No. 

Categories Click to select one or more categories to which this client 
belongs. 

No. 

 
  



26 • Getting Started Today 

Time tab 

This tab displays the fields that are Time -specific. Detailed information about each field is 
available in the Time Help system. 

 
Field 

 
Description 

Synchronizes with Time Clients 
Setup dialog 

Client no. Number assigned to the client Yes. Only the first 10 characters are 
synchronized to the Time file. 

Name Name from the Company field on the 
General tab  

Yes. Synchronizes to Client Name field. 

Short The first 10 characters of the company 
name. 

Yes. 

Group Mark this box if the client is a parent 
company and represents other divisions 
of the company. 

Yes. This is synchronized as a group 
and it can be viewed in the group's 
dialog. 

Type Select from the list. Note that to set a 
client as inactive, you must change the 
type in Time. All other client types are 
available to be assigned from Outlook. 

Yes except for inactive clients. Inactive 
clients can be synchronized from Time 
to Today only, not from Today to 
Time. 

Inactive date The date the client was made inactive. Yes. 
Group no. ID assigned to the group Yes. Only the first 10 characters are 

synchronized to the Time file. 
Is Group Flag showing this is a group client. Yes.  

 

The Time tab includes the following tabs for additional information: 

 
Field 

 
Description 

Synchronizes with Time Clients 
dialog 

Alternate Address This dialog is identical to the Alternate 
Address tab of the Time client dialog. 

Yes. To the identically-named fields. 

Attention This dialog is identical to the Attention 
tab of the Time client dialog. 

Yes. To the identically-named fields. 

Billing info This dialog is identical to the Billing info 
tab of the Time client dialog. 

Yes. To the identically-named fields. 

Tax info This dialog is identical to the Tax info 
tab of the Time client dialog. 

Yes. To the identically-named fields. 

Other info This dialog is identical to the Other info 
tab of the Time client dialog. 

Yes. To the identically-named fields. 

Memo To be used for entering additional info Yes. To the Memo tab. 
 

Custom tab  Provides extra information regarding the client. Entries made here can be 
used to filter items on the home page or to enable advanced searching by 
Time fields. 

Details tab  This tab is a Microsoft Outlook tab. Enter data and settings needed to carry 
out Outlook functions such as scheduling and emailing. 

Activities tab  [Outlook 2003] Click the "Show" drop-down list to view files, knowledge 
articles, meeting (discussion) items, performance metrics, scheduled events, 
tasks, or training materials associated with this staff. 
 
[Outlook 2010] Click the “Show” drop-down list to view Contacts, Emails, 
Journals, Notes, Upcoming Tasks/Appointments. 
 
New items for this staff must be set up in the similarly-named Today folder 
(Files, Knowledge, Meeting, (Performance) Metrics, Schedule, Tasks, or 
Training). 
 



Today Getting Started • 27 

Contacts Folder and Contact Companies Folder 

 The Contacts folder displays contact information for people who are important to your clients. 
The Contacts Companies folder displays contact information for companies related to your firm. 

On the Contacts or Contact Companies home page, you will see the summary listing of all the 
contacts or contact companies in the database. 

Show Me 

In addition to the standard folder views, the following views are available in the Contacts and 
Contacts Companies folder: 

• Phone List to list client contacts or contact companies along with their phone numbers and other basic information. 
• Address cards: view basic information about client contacts or contact companies in an address-card format. 
• Detailed address cards: view detailed information about client contacts or contact companies in an address-card 

format. 
• Contacts grouped by client: Group together those who are contacts or contact companies of the same client. 
• Contacts grouped by type: Group together client contacts or contact companies that belong to the same type 

such as insurance (INS), legal (LAW), financial (FIN). 
• Contacts grouped by follow-up flag: group together client contacts or contact companies that are flagged for 

follow-up. 

Note: 
When modifying fields that uniquely identify contacts or contact companies, a message 
appears to determine if you are updating the existing record for the contact type or 
creating a new one. Select "Yes" to create a new contact or contact company, or select 
"No" to modify the existing contact record. 

• If modifying the "Last name" field of contacts, then the message "Do you want to create a new contact?" appears. 
• If modifying the "Company name" field of contact companies, then the message "Do you want to create a new contact 

company?" appears. 

General tab 

Based on the Microsoft standard form for contacts, this tab provides general information 
regarding the contact or contact company. For more information on the features available, 
refer to the MS Outlook Help. 

 
Field 

 
Description 

Synchronizes with Time Contacts 
dialog 

Full name Full name of the person to contact Yes. This name synchronizes with the 
Contact Full Name. 

Job Title Job Title of the person to contact.  Yes. This name synchronizes with the 
Title field. 

Company Company Name Yes. This name synchronizes to 
Contact name 
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Field 

 
Description 

Synchronizes with Time Contacts 
dialog 

File As You have the option display the 
record on the Contacts home page 
in one of several ways. Click the 
look-up button for a selection of 
formats. 
To set the default selection the 
following steps must be taken: 
[Outlook 2003] 
1 From Tools menu select Options 
2 In Preferences tab, click Contact 

options. 
3 In Contact options dialog, select 

Company from the listing for 
Default "File As" order. 

[Outlook 2010] 
1. From the File tab select Options. 
2. Select the Contacts option. 
3. Under Names and filing, select 

Company from the Default “File 
As” order drop-down. 

No. 

Business, Home, 
Business Fax, Mobile 

Name of these fields can be selected 
and changed from the list. 

Yes. To the fields in Address tab. 

Address Contact's mailing address Yes. To the fields in Address tab. 
Email Email address of the Contact Yes. To the field in Address tab. 
Web page address Web page address of the contact Yes. To the field in Address tab. 
Notes area Enter any additional information as 

needed. 
No. 

[Contact Companies 
Only] Contacts  

Click the button to select one or 
more people in your contacts list 
who are associated with this client. 

No. 

[Contact Companies 
Only] Categories 

Click the button to select one or 
more categories to which this client 
belongs. 

No. 

Time tab 

This tab displays the fields that are Time-specific. Detailed information about each field is 
available in the Time Help system. 

 
Field 

 
Description 

Synchronizes with Time Contacts 
dialog 

Last Name Surname of the contact person Yes. 
Pre Name Personal title of the contact person (e.g. 

Mr., Mrs., Ms., etc.). The pre name 
accepts a maximum of 15 characters. 

Yes.  

Type Type code of the Contact.  
 
Example:"LAW" for lawyer of the client.  
 
Click the button to select another type. 
You can set up Contact types from the 
Administration  Options folder. 

Yes. 

First Name First name of the contact person Yes. 
Post Name Post name for the contact person (e.g. 

C.A., Ph D.) 
Yes. 

Title Title or position of the contact person Yes. 
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Field 

 
Description 

Synchronizes with Time Contacts 
dialog 

Full Name This field is automatically generated by 
the four preceding Name fields (Last, Pre, 
First and Post Names). 

Yes 

Company The associated Contact Company. Yes 
Email Email address of the contact person Yes. 
Client no. ID(s) of the Client(s) to which the Contact 

belongs. a contact may belong to more 
than one client. Click the button to select 
more clients. 

Yes. 

Client names Full name(s) of the client(s) selected in 
the Client No. field. 

Yes. 

 
Details tab 
Certificates tab 

 These tabs are Microsoft Outlook tabs. Enter data and settings needed to 
carry out Outlook functions such as scheduling and emailing. 

Address/Phone tab  This tab defines contact and addressing information for the contact person. 
Client/Group tab  ID(s) of the Client(s) to which the Contact belongs. A contact person may 

belong to more than one client. 
Other Info tab  Alternate Codes and Dates used to identify and group contact people. 
Memos tab  Descriptions or notes about the contact person. 
Activities tab  [Outlook 2003] Click the "Show" drop-down list to view files, knowledge 

articles, meeting (discussion) items, performance metrics, scheduled events, 
tasks, or training materials associated with this staff. 
 
[Outlook 2010] Click the “Show” drop-down list to view Contacts, Emails, 
Journals, Notes, Upcoming Tasks/Appointments. 
 
New items for this staff must be set up in the similarly-named Today folder 
(Files, Knowledge, Meeting, (Performance) Metrics, Schedule, Tasks, or 
Training). 
 

Connecting Contacts to Clients in Today 

In CaseWare® Time, contacts' records are reached directly from the records of the clients 
they're assigned to. In Today, to see that relationship or assign a contact to a client, use the 
Contact's Time tab.  

1. Click the Contacts folder. 
2. Double-click the contact record to open or click New Contact to create a new record. 
3. When the record opens, click the Time tab. 
4. Click the Client tab. 
5. Click the Client No. button. 
6. When the Select Clients dialog opens, do the following. 

a. Click the field list and select either Client No. or Client Name. 
b. In the value field, enter the term to search. 
c. In the Condition list select the best description for the entry in the value field, Begins with, Contains, 

Is (Exactly), or Doesn't Contain. 
7. Click the Search button. 

Further actions available in the Select Clients dialog. 
To Do 
See the full list again Clear the Value field and click Search. 
Add a client to the contact's list Check the box to the left of the client number. 
Remove a client from the contact's list Clear the check box. 
Filter the list so only the clients that this 
contact is associated with are visible 

Click the check box Selected Items Only. 

See all clients again Clear the Selected Items Only check box. 
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Files Folder 

The Files folder lets you post documents for the team or read documents posted by others. It 
does not synchronize with Time. 

You can drag and drop files from anywhere on your workstation or network to this folder for quick 
access. 

On the Files home page, you will see the summary listing of all the documents posted to the File 
Room. 

Show Me 

In addition to the standard folder views, the following views are available in the Files folder: 

• Grouped by client: Group together all documents pertaining to the same client. 
• Grouped by project: Group together all documents pertaining to the same project. 
• Grouped by staff: Group together all documents written by or assigned to the same staff member. 
• Grouped by author: Group together all documents written by the same person. 
• Grouped by type: Group together all documents assigned to the same type. 

When you double-click a file in the list, you will open the File dialog. 

Message tab 

Attach the file and enter identifying information and comments about the file here. File 
document types such as MS Word, CaseView or Excel, can be set up in the Administration  
Options folder. 

Details tab (Optional) 

Select Time-related information about the file. Selections made here can be used to filter items 
on the home page or to enable advanced searching by Time fields. 

Add an existing document to the folder 
1. Use Windows Explorer or My Computer to find the document file you want to copy. 
2. Drag the file from Windows Explorer or My Computer to the document list to the large field on the Message tab. 
3. Enter identifying information about the files in the Subject, Author and Type fields. 
4. Enter any comments about the file in the large message field. For example, include creation or modification 

dates. 
5. Click the details tab to select Time-related information about the file. 

Knowledge Folder 

The Knowledge folder lets you post reference material for the team or read reference material 
posted by others. Post materials relevant to your industry and firm such as accounting 
handbooks, reference guides, tax guides, and the Time user guide. 

On the Knowledge home page, you will see the summary listing of all the knowledge messages 
and documents posted. 

Show Me 

In addition to the standard folder views, the following views are available in the Knowledge 
folder: 

• Grouped by reference: Group together all knowledge material belonging to the same reference. 
• Grouped by project: Group together all knowledge material belonging to the same project. 
• Grouped by staff: Group together all knowledge material belonging to the same staff member. 
• Grouped by author: Group together all knowledge material written by the same person. 
• Grouped by client: Group together all knowledge material belonging to the same client. 
• Unread items: View only those knowledge material s you haven't read or marked as read yet. 

When you double-click a file in the list, you will open the Knowledge dialog. 

Message tab 
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Enter the reference material, attach associated files and include any identifying information 
and comments about the material here. 

Details tab (Optional) 

Select Time-related information about the reference material. Selections made here can be 
used to filter items on the home page or to enable advanced searching by Time fields. 

Meeting Folder 

The Meeting folder lets you post messages for the team and read messages posted by others. 
The messages are organized in groups called conversations. 

On the Meeting home page, you will see the summary listing of all the conversations posted. 

Show Me 

In addition to the standard folder views, the following views are available in the Meeting folder: 

• Grouped by client: Group together all messages belonging to the same client. 
• Grouped by project: Group together all messages belonging to the same project. 
• Grouped by contact: Group together all messages belonging to the same contact. 
• Grouped by staff: Group together all messages belonging to the same staff member. 
• Grouped by conversation: Group together all messages belonging to the same conversation thread. 
• Grouped by sender: Group together all messages written by the same person. 
• Unread items: View only those messages you haven't read or marked as read yet. 

When you double-click a meeting in the list, you will open the Meeting dialog. 

Message tab 

Enter the message and include any identifying information and comments about it here. 

Details tab (Optional) 

Select Time-related information about the message. Selections made here can be used to filter 
items on the home page or to enable advanced searching by Time fields. 

Start a new conversation thread 
1. Click New Post. 
2. In the Subject box, type the name of the new thread. 
3. In the message body, type the message. 
4. Click Post. 

Reply to a message in a conversation 
1. Select the message to which you want to reply. 
2. Click Post Reply. 
3. The Subject box should be filled in automatically. It is best not to change the subject. 
4. In the message body, type your reply. Quote from the original message as needed. 
5. Click Post. 

Send mail to the author of a message 
1. Select the message to which you want to reply. 
2. Click Reply to Sender. 
3. In the message body, type the message of your reply, quoting from the sender's message as needed.. 
4. Click Send. 

Mark all messages as read 
1. Click Mark All as Read. 

Tip You can mark any message as read or unread. To do so, right-click the message, and then click Mark as 
Read or Mark as Unread on the shortcut menu. 
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Metrics folder 

The Metrics folder displays the metrics (performance indicators) used by your firm. Corporations 
use many measures to track performance, especially for lead indicators. Here you can post 
information about those used in your firm. 

On the Metrics home page, you will see the summary listing of all the performance indicators. 

Show Me 

In addition to the standard folder views, the following views are available in the Metrics folder: 

• Metrics grouped by client: Group together all metrics assigned to the same client. 
• Metrics grouped by project: Group together all metrics assigned to the same project. 
• Metrics grouped by author: Group together all metrics assigned to the same author. 

When you double-click a metric record, you will open the Metrics dialog. 

Message tab 

Enter details of the performance metric and include any identifying information and comments 
about it here. Types of metrics can be set up in the Administration  Options folder. 

Details tab (Optional) 

Select Time-related information about the performance metric. Selections made here can be 
used to filter items on the home page or to enable advanced searching by Time fields. 

Projects Folder 

Store projects of your practice. You can have files stored right in the project records and then drill 
down to these files as needed. 

 Note 

• In Today 2013 Projects information is synchronized in one direction only – from Time 2013 to Today 2013. 

• Project information loaded in Outlook is presented in READ-ONLY format. You cannot modify project records from 
Outlook. 

On the Projects home page, you will see the summary listing of all the projects posted. 

Show Me 

In addition to the standard folder views, the following views are available in the Projects folder: 

• Projects grouped by client: Group together all Projects for the same client. 
• Projects grouped by type: Group together all Projects that are assigned to the same type. Note that the grouping 

will say Engagement Type, but it will reflect the types entered in the Project Types folder under Administration  
Options. 

• Active projects: Group together all Projects that are still in progress. 
• Completed projects: Group together all Projects that have been completed. 

When you double-click a project record, you will open a dialog that looks very much like the 
Projects dialog in the Client Setup of Time. 

Project tab 

Provides general information regarding the project. 

 
Field 

 
Description 

Synchronizes with Time Project 
dialog in the Client setup 

Client ID of the Client to which the Project is 
assigned. 

Yes. 

Project The Client Project. Yes. 
In charge The name of the person in charge of the 

project. 
Yes. 

Client name Full name(s) of the client(s) selected in Yes. 
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Field 

 
Description 

Synchronizes with Time Project 
dialog in the Client setup 

the Client no. field.  
Type The code identifying the Project. Click 

the button to select another type. Project 
types can be set up in the Administration 
 Options folder. 

Yes. 

Team leader The name of the person leading the 
project. 

Yes. 

Default Project Check box flagging that this is the 
default project for a client. 

Yes. 

Contact The Contact Name Yes. 
Staff no. Identification number of the staff member 

to whom the Project is assigned. Click 
the button to select other staff members. 

 

Staff names Full name(s) of the staff member(s) 
selected in the Staff no. field. 

Yes. 

Attachment and 
description 

Store any files and related information 
for the project here. 

 

Notes area Enter any additional information as 
needed. 

No. 

Contacts Click the button to select one or more 
people in your contacts list who are 
associated with this client. 

No. 

Categories Click the button to select one or more 
categories to which this client belongs. 

No. 

Details tab 

Provides extra information regarding the project. Entries made here can be used to filter items 
on the home page or to enable advanced searching by Time fields. 

 
Field 

 
Description 

Synchronizes with Time Project 
dialog in the Client setup 

Contract amount The amount of any contracted amount 
for the project. 

Yes. 

WIP limit The Work In Process limit for the project. Yes. 
Budget hours Budget total hours calculated 

automatically from detailed entries in the 
Project and Sub-project dialogs of Time. 

Yes. 

Budget amount Total of amounts budgeted calculated 
automatically from detailed entries in the 
Project and Sub-project dialogs of Time. 

Yes.  

Start date The start date for the project. Yes.  
Status The current status of the project. No. 
Due date The projected due date for the project. Yes. 
Completion date The completion date for the project. Yes. 
Priority Select a priority for this project. No. 

 
Activities tab  [Outlook 2003] Click the "Show" drop-down list to view files, knowledge 

articles, meeting (discussion) items, performance metrics, scheduled 
events, tasks, or training materials associated with this staff. 
 
[Outlook 2010] Click the “Show” drop-down list to view Contacts, Emails, 
Journals, Notes, Upcoming Tasks/Appointments. 
 
New items for this staff must be set up in the similarly-named Today folder 
(Files, Knowledge, Meeting, (Performance) Metrics, Schedule, Tasks, or 
Training). 
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Connecting Projects to Staff or Client Contacts in Today 

In Today, to assign a project to a staff member or contact or to see the staff or contacts 
assigned to a project, use the Project tab.  

1. Click the Projects folder. 
2. Double-click the project record to open. 
3. If it is not already active, click the Project tab. 
4. Click the Contact or the Staff no. button, as appropriate. 
5. When the Select dialog opens, do the following. 

a. Click the field list and select either number or name. 
b. In the value field, enter the term to search. 
c. In the Condition list select the best description for the entry in the value field, Begins with, Contains, 

Is (Exactly), or Doesn't Contain. 
6. Click the Search button. 

Further actions available in the Select dialog. 
To Do 
See the full list again Clear the Value field and click Search. 
Add a staff or contact to the project's list Check the box to the left of the staff or contact 

number. 
Remove a staff or contact from the 
project's list 

Clear the check box. 

Filter the list so only the staff or contacts 
that this project is associated with are 
visible 

Click the check box Selected Items Only. 

See all staff or contacts again Clear the Selected Items Only check box. 

 

Schedule Folder (group) 

The Schedule folder displays meetings and other events that are important to your team. Use it to 
plan activities at the group level such as meetings, phone calls, trips, on-line meetings, and 
WebEx events. 

On the Schedule home page, you will see the summary listing of all the events scheduled. 

Show Me 

In addition to the standard folder views, the following views are available in the group 
schedule: 

• Schedule for one day: View a single day's appointments and events. 
• Schedule for work week: View all appointments and events occurring on days that fall within the current work 

week. 
• Schedule for full week: View the next seven days' worth of appointments and events. 
• Schedule for full month: View all the appointments and events for the current month. 

When you double-click an appointment, event, or time period in the schedule, you will open the 
Appointment dialog. TimeAppointment dialog. Enter data and settings needed to carry out 
Outlook functions such as scheduling and emailing. 
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Appointment and Attendee Availability tabs 

The fields here are identical to the MS Outlook Appointment dialog. More information about 
these tabs can be found in the MS Outlook help system. 

Details tab (Optional) 

Select Time-related information about the event. Selections made here can be used to filter 
items on the home page or to enable advanced searching by Time fields. 

View a different day, week, or month 
• If you are viewing appointments and events for a single day or week, select the days you want to view in the schedule to the 

right of the daily or weekly view. If the days you want to view are not displayed on the schedule, click the right or left arrow at 
the top of the monthly schedule to bring the appropriate month into view. 

• If you are viewing appointments and events for an entire month, use the vertical scroll bar to the right of the schedule to bring 
into view the month you want to see. 

• To return to viewing the current day, week, or month, click Go to Today. 

Add an appointment or event to the schedule 
1. Click New Schedule or New Meeting Request. 
2. In the Subject box, type the purpose or name of the meeting or event. 
3. In the Start Time and End Time boxes, enter the times when the meeting or event is to begin and end. 
4. In the Location box, type the location where the meeting or event is held. 
5. In the message body, type details of the meeting or event. 
6. To create an event, select the All day event check box. The event is displayed at the top of each day on which 

it occurs. 
7. Click Save and Close. 

Tip To notify others about the meeting and add it to their personal schedules, click Invite Attendees to create 
a meeting request. See the next topic for information about working with a meeting request. 

Request a meeting with someone else 
1. Click New Schedule or New Meeting Request, and then click the Invite Attendees button. 
2. In the To box, type the name or names of the people you want to have present, or click To to select names from 

your address book. 
Important: To see free and busy times for other attendees, the names you enter must be in your organization's 
Global Address List. Note that in order to add the meeting to your personal schedule, you must include yourself 
in the To box. 

3. In the Subject box, type the purpose of the meeting. 
4. In the Location box, type the location where the meeting is held. 
5. In the message body, type details of the meeting. 
6. To select a time when attendees are not busy, click Attendee Availability and then move the green and red 

vertical bars. 
7. Click Send. 

Staff Folder 

The Staff folder displays information for the people on your team. Only active staff members' 
records are synchronized between Time and Today. 

On the Staff home page, you will see the summary listing of all the staff members in the 
database. 

Show Me 

In addition to the standard folder views, the following views are available in the Staff folder: 

• Phone List: List staff along with their phone numbers and other basic information. 
• Address cards: View basic information about staff members in an address-card format. 
• Detailed address cards: View detailed information about staff in an address-card format. 
• Staff grouped by position: Group together staff that belong to the same position. 
• Staff grouped by follow-up flag: Group together staff that are flagged for follow-up. 

When you double-click a staff record, you will open a dialog that looks very much like the Staff 
dialog in Time, including tabs dividing the staff information into categories. 
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General tab 

Based on the Microsoft standard form for contacts, this tab provides general information 
regarding the staff member. For more information on the features available, refer to the MS 
Outlook Help. 

 
Field 

 
Description 

Synchronizes with Time Staff dialog 

Full name Full name of the staff Yes. First and last names are 
synchronized. 

Company Company name No. 
File As You have the option display the 

record on the Staff home page in 
one of several ways. Click the look-
up button for a selection of formats. 
To set the default selection the 
following steps must be taken: 
[Outlook 2003] 
1 From Tools menu select Options 
2 In Preferences tab, click Contact 

options. 
3 In Contact options dialog, select 

Company from the listing for 
Default "File As" order. 

[Outlook 2010] 
1. From the File tab select Options. 
2. Select the Contacts option. 
3. Under Names and filing, select 

Company from the Default “File 
As” order drop-down. 

No. 

Business, Home, 
Business Fax, Mobile 

Name of these fields can be selected 
and changed from the list. 

Yes. To the fields in Address tab. 

Address Staff mailing address. Yes. To the fields in Address tab. 
Email Email address of the staff. Yes. To the field in Address tab. 
Web page address Web page address. Yes. To the field in Address tab. 
Notes area Enter any additional information as 

needed. 
No. 

Contacts Click the button to select one or 
more people in your contacts list 
who are associated with this client. 

No. 

Categories Click the button to select one or 
more categories to which this client 
belongs. 

No. 

Time tab 

This tab displays the fields that are Time-specific. Detailed information about each field is 
available in the Time Help system. 

Address/Phone tab  This tab defines contact and addressing information for the staff member. 
Profile tab  This tab defines information related to a staff members role(s). 
   
 
Field 

 
Description 

Synchronizes with Time Staff dialog 

Staff no. Number assigned to the Staff. Yes. Only the first 4 characters are 
synchronized to the Time file. 

Name Name from the "file as" field on the 
General tab 

Yes. 
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Type The only type available to be 
assigned to a staff member is Active. 
Note that to set a staff member as 
inactive, you must change the type 
in Time. All other client types are 
available to be assigned from 
Outlook. 

Yes. Only records of "active" staff is 
synchronized. Inactive staff can be 
synchronized from Time to Today 
only, not from Today to Time. 

Start date The day that the staff member joined 
the organization. 

 

Inactive date The day that the staff member was 
made inactive. 
You can make staff members 
inactive who do have outstanding 
time or expense entries as long as 
those entries are in the current or a 
previous period. In other words, the 
entries must be in a period prior to 
the inactive date. 

 

SIN/SSN Social insurance/security number of 
the staff. 

Yes. 

Position ID code for the staff member's 
position. Position codes can be set 
up in the Administration  Options 
folder. 

Yes. 

 

Details tab 
Certificates tab 

 These tabs are Microsoft Outlook tabs. Enter data and settings needed to 
carry out Outlook functions such as scheduling and emailing.  

Activities tab  [Outlook 2003] Click the "Show" drop-down list to view files, knowledge 
articles, meeting (discussion) items, performance metrics, scheduled events, 
tasks, or training materials associated with this staff. 
 
[Outlook 2010] Click the “Show” drop-down list to view Contacts, Emails, 
Journals, Notes, Upcoming Tasks/Appointments. 
 
New items for this staff must be set up in the similarly-named Today folder 
(Files, Knowledge, Meeting, (Performance) Metrics, Schedule, Tasks, or 
Training). 
 

 

Tasks Folder 

The Team Tasks folder lets you post "to-do" items at the group level and read items posted by 
others. This does not synchronize with personal tasks. 

Enter data about work to be done on clients’ records such as budgeting time and inputting 
invoices. The task may be assigned to a staff member and/or linked to a contact as applicable. 

Currently the Tasks folder does not synchronize with Time. It is introduced for your use in MS 
Outlook to help you organize work needed on clients’, staff and contacts’ records. 

On the Tasks home page, you will see the summary listing of all the team tasks posted. 

Show Me 

In addition to the standard folder views, the following views are available in the Tasks folder: 

• Tasks grouped by ____: Group together all tasks that are assigned to the same area (client, project, staff, or type) 
or category. 

• Active tasks: View only those tasks which are currently in progress. 
• Completed tasks: View only those tasks which are marked as complete. 
• Overdue tasks: View only those tasks which are currently overdue. 

When you double-click, you will open the TimeTask dialog. 
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Task and Details tabs 

The fields here are identical to the MS Outlook Task dialog. More information about these tabs 
can be found in the MS Outlook help system. 

Time tab (Optional) 

Select Time-related information about the task. Selections made here can be used to connect 
the task to a specific client, project, client contact or staff member. Any tasks thus assigned will 
appear on the Activities tab of the associated client, contact, project or staff record (in Today 
only). 

You can also use the selections to filter items on the home page or to enable advanced 
searching by Time fields. 

Viewing tasks in the Activities tab of the applicable Client, Contact or Staff folder 

When installing Today, you must do some basic setup to interact each folder with the activities 
list.  

 Tips 

• Use this technique to add schedules, meeting or any other folder group to the activities tab. 
• You can drag and drop reports from the Document Manager in Time to the Tasks and Activities lists in Outlook to help set up 

your to do list. 

1. Click the right mouse button on the Clients, Contacts or Staff folder icon and select Properties.  
2. Click the Activities tab. 
3. Select an item in the Folder groups window and click Modify; 

OR 
Click the New button. 

4. Find the Task folder in which you are storing your Today task information and check the box. 
5. Click OK to accept the choice. 
6. If making a new folder, click OK in the Properties dialog to accept "New folder group" in the default view for the 

Activities tab. 
7. Open the client, contact or staff record to which the task is assigned and click the Activities tab. 
8. Click the Show list and select the folder group that you changed or added above. You should be able to see the 

task assigned. 

The differences between Team Tasks and the "My Tasks" list 

Team Tasks and your personal task list are separate from each other. Tasks that appear in 
one will not appear in the other. However, you can copy a task from Team Tasks to your 
personal task list. 

To copy a task to your personal task list 
From within the task: 

1. Double-click the task to open it.  
2. On the File menu, click Copy to Folder.  
3. In the Folders list, locate and select your personal Tasks folder. 
4. Click OK and then close the Task dialog. 

From the list view: 
Either  

• Select the task and click Edit  Copy to Folder; 
OR 

• Hold down the Control key and then drag-and-drop the task to your personal Tasks folder. 

Training Folder 

The Training folder lets you post training documents for the team, information about upcoming 
courses, or read training information posted by others. 

On the Training home page, you will see the summary listing of all the training materials and 
information posted. 
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Show Me 

In addition to the standard folder views, the following view is available in the Training folder: 

• Training grouped by ____: Group together all training documents that are assigned to the same area (client, 
project, staff, or type) or category. 

When you double-click a training record, you will open the Training dialog. Training types can 
be set up in the Administration  Options folder. 

Message tab 

Enter training material, attach related files and enter identifying information and comments 
about it here. Training types can be set up in the Administration  Options folder. 

Details tab (Optional) 

Select Time-related information about the training information. Selections made here can be 
used to filter items on the home page or to enable advanced searching by Time fields. 

Administration - Options Folder 

Card, Contact, Engagement, Other, Position, Project, Predicate type and Status types 
synchronize with Time. Before synchronizing, set up additional type codes to be used in Today 
such as those needed for Documents, Metrics, Tasks and Training. 

 Note 

• Information entered in the References, Sources and Systems sub-folders will not be synchronized to the Time file. 

Card types Double-click from the home page listing to enter the codes and descriptions 
for credit cards. This is used on the Billing Info tab of Client records. 

Contact types Double-click from the home page listing to enter the codes and descriptions 
for different types of contacts that your clients have such as lawyers, 
insurance companies and banks. 

Document types Double-click from the home page listing to enter the types of documents 
used in your projects, such as CaseView, Working Papers, or MS Excel. 

Engagement types Double-click from the home page listing to enter codes and descriptions for 
the types of auditing engagements taken on by your company. This is used 
on the Other Info tab of Client records. 

Metric types Double-click from the home page listing to enter the codes and descriptions 
for the metrics (performance indicators) used by your firm. Corporations use 
many measures to track performance, especially for lead indicators.  

Other Double-click from the home page listing to enter the codes and descriptions 
for the "Other" fields 1 to 8 found on the Other Info tab of Client and Contact 
records. These fields can be used to classify miscellaneous client 
information such as taxes, deductions and insurance plans. 

Positions Double-click from the home page listing to enter the codes and descriptions 
for job positions in your firm. 

Predicate types Double-click from the home page listing to enter the codes and descriptions 
for the predicates used by clients and contacts of your company. This is 
used on the attention tab of Client records. 

Project types Double-click from the home page listing to enter codes and descriptions for 
the types of projects taken on by your company. 

References Not available. 
Sources Not available 
Status Double-click from the home page listing to enter the codes and descriptions 

for status. Status codes can be used to indicate material that is sent to the 
client such as newsletters, quarterly or annual reports, and special bulletins. 
This is used on the Other Info tab of Client records. 

Systems Not available 
Task types Double-click from the home page listing to enter the codes and descriptions 

for different types of tasks performed. 
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Training types Double-click from the home page listing to enter the codes and descriptions 
for different types of training provided. 

Updating from a previous version of Today 

 Note 

• There is no upgrade procedure from Today 2011 to 2013. The setup procedure is the same as setting up Today for the first 
time when you are upgrading from a previous version. You need to convert your Time 2011 files to Time 2013, and then 
synchronize data from Time 2013 to Today 2013. 

To update from the previous version, first you must set up a new folder with a name that is 
unique from the previous version and follow the procedure above to set up the folder structure 
needed in the latest version of Today. Do not use the previous version's folder. 

Today detects forms created in the previous version during the form setup process and asks you 
to confirm that you want to copy and convert the data in the old forms to the new forms. You 
should click OK and complete the following steps: 

1. In the form conversion dialog, browse to select the previous version's Today folder (Source folder). Ensure that 
you select the top level folder and not a subfolder. 

2. Browse to select the new version's folder (Destination folder). Again, ensure that you select the top-level folder. 
3. Click Convert. Today sets the properties of the folders and subfolders and copy the data from the old to the new 

version. 
4. When the process is finished, you'll be asked to delete the old version. Answer "No". This leaves the old version 

data in Outlook for review. When you are sure that the data has been converted properly, you can delete the 
previous Today folder. 

5. Run a synchronization from Time to Today. If any new fields have been added to records in Time, they will be 
set up in Today and any data in them copied to Today. 

6. Click Close. 

 Warning 

• Do not try to copy the forms manually from the previous version to the new version of Today. They will not function correctly 
and will overwrite the ones set up during the conversion process. 

 Note 

• If you decide to keep the old forms, they cannot be synchronized to the latest release of Time. 

Have you already installed a version of Today 2013? 

If an earlier version (e.g., a beta version) of Today 2013 is already installed on your computer, 
you need to perform the following steps to prevent getting error messages when setting up forms 
in the newly-released version. 

1. Before installing a newly-released version, remove the prior version (e.g., beta version) of Today 2013 using the 
Add/Remove Programs function found in the Windows Control Panel.  

2. Delete the previous Today folder from Outlook. This was created during the previous installation. Removing it 
deletes all the forms created in the earlier version. Even if you have not actively used the previous installation, 
you should remove this folder. 

3. Close Outlook. 

Delete the Frmcache.dat file. (See below for instructions). The previous version's forms layout 
are stored in this file, and they may cause a conflict with the forms in the newly-released version.  

To find and delete the Frmcache.dat 

Method 1: Use the Clear Cache Button 

If you are using Microsoft Outlook 2003 SR1 or higher and you have Outlook configured in the 
Corporate/Workgroup (CW) mode, you can use the Clear Cache button to reset the Outlook 
forms cache.  

To verify the SR-1/SR-1a version of Outlook that you have installed and if it is configured in 
CW mode, click the Outlook Help menu, and then click About Microsoft Outlook. 
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[Outlook 2003] Use the following steps to use the Clear Cache button:  
1. On the Tools menu, click Options, and then click the Other tab.  
2. Click Advanced Options.  
3. In the Advanced Options box, click Custom Forms.  
4. In the Custom Forms box, click Manage Forms.  
5. In the Forms Manager box, click Clear Cache. 

[Outlook 2010] Use the following steps to use the Clear Cache button:  
1. Click Files tab and click on Options.  
2. Click Advanced.  
3. Scroll down to Developers options. 
4. Click Custom Forms.  
5. In the Custom Forms box, click Manage Forms.  
6. In the Forms Manager box, click Clear Cache. 

Method 2: Delete the Forms Cache Files 

If you have Outlook and you do not have Outlook 2003 SR-1/SR-1a or higher installed, or if 
you are using Outlook in the Internet Mail Only (IMO) mode, you can delete the forms cache 
file manually. The forms cache is stored in a folder called Forms. 

The Forms folder may be located in one of many locations depending on the operating system 
that you are using and how you have the operating system configured. 

The Frmcache.dat file is the primary file to delete. The Frmcache.dat file serves as an index of 
the individual forms that have been cached on the computer. Use the following steps to 
manually delete the Frmcache.dat file. In addition, these steps delete all of the cached forms 
on your computer, which are stored in subfolders of the Forms folder. 

1. Quit Outlook. 
2. Click the Microsoft Windows Search or File command to locate the Frmcache.dat file on your hard disk. Click to 

select the Frmcache.dat file. 
3. On the File menu, click Open Containing Folder to open the Forms folder in a separate window. 
4. Rename or Delete all or specific files. 

When you restart Outlook, and use a custom form, the forms cache is re-created. Until a 
custom form is used, Outlook does not re-create the Frmcache.dat file. 

More information 

More information is available from the Microsoft Knowledge base. 

http://support.microsoft.com/default.aspx?scid=kb;en-us;290806#HowWorks  
http://support.microsoft.com/default.aspx?scid=kb;en-us;839804  
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Getting help 
Today comes equipped with a complete online help that includes both reference and step-by-
step information. There are several ways of getting the information you need. 

Context sensitive help 

 
 

Information to guide you as you use Today is a button click away. Clicking the 
Help button in a particular dialog box, or a of the browse windows to pop up an 
explanation of the function performed by that function or dialog. 

Procedures and reference information 

 When you click the Help link at the top of any Today browse in Outlook, you can 
access a complete online reference guide for your application. This is where to 
head for detailed information to guide you through a particular task, browse or 
dialog box. 

Click the Contents button to go to get the following online help tabs: 

 Click this tab to see the Help system arranged into chapters and sections of 
related topics. Chapters and section heads appear as book icons and the topics 
are represented by page icons. Double-click a topic page to see the procedure 
referenced.  
From the Contents tab you can print a topic. Select the icon and then click the 
Print button. 

 For fast searching through the Help system, use the Index of keywords arranged 
like a traditional book index. Type in the first few letters of the topic until it appears 
in the index listing. 

 The Search tab provides full-text searching through the Help system for a 
particular word or phrase Type in the first few letters of the term until it appears in 
the listing. 

 Use favorites to set links to topics you consult a lot. (HTML help only.) 

Printed user guide 

If you prefer to have a printed version of the Today User Manual, we have included it in PDF file 
format.  

You will need to use the latest version of Adobe® Reader® and the latest drivers for your printer 
to read and print this file. Adobe® Reader® is a free download and is available from Adobe's 
website at www.adobe.com.  

To open and print the manual, click the Windows Start menu and select the folder where you 
installed the program. Within the folder is a subfolder for the Today documentation. It contains 
the user guide which is called Today 2013 User Guide. In addition, this Getting Started Guide is 
also listed, allowing you to print extra copies as needed. 

 
 

Resources on the website  

The website is rich with additional information to help you use Today as effectively and efficiently 
as possible. 

Getting Technical Support 

Please refer to the Time Getting Started Guide for information on getting technical support for 
Today. 
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